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How to Use This Guide 
This manual is designed to help you use the ACLS-DLL2 software driver for 
NuDAQ ISA-bus multi -function cards ACL-6126, ACL-6128, ACL-8216, ACL-
8316, ACL-8111, ACL-8113, ACL-8113A, and ACL-8112 series. The manual 
describes how to install and use the library to meet your requirements and help 
you program your own software application. When you are familiar with the 
material in this manual, you can begin to use the ACLS-DLL2 Function 
Reference Manual. The ACLS-DLL2 Function Reference Manual contains 
detailed descriptions of the ACLS-DLL2 functions. You also can use the help 
file ACL-DLL2.HLP, located in your ACLS-DLL2 software, which contains all of 
the function reference material.  

The ACLS-DLL2 User’s Guide is organized as follows: 

 
• Chapter 1, "Introduction to ACLS-DLL2" gives an overview of the contents 

included in the software package and describes how to install the software 
and create your applications by using ACLS-DLL2. 

• Chapter 2, "Software Overview” briefly describes the function calls ACLS-
DLL2 provides. 

• Chapter 3, "Sample Programs" describes the sample programs in the 
software diskette. 
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1 

Introduction to ACLS-DLL2 

1.1 What is ACLS-DLL2 
 

ACLS-DLL2 is the Microsoft Windows drivers for NuDAQ ISA-bus multi -
function cards ACL-6126, ACL-6128, ACL-8111, ACL-8113, ACL-8113A, ACL-
8112DG/HG, ACL-8112PG, ACL-8216 and ACL-8316/12.  They are high 
performance data acquisition drivers for developing custom applications under 
Windows 3.1, Windows 95/98, Win-NT 4.0 and Windows 2000.  These drivers 
are DLLs (Dynamic-Link Library) for using under Windows.  They can work 
with any Windows programming language that allows calls to a DLL, such as 
Microsoft C/C++, Microsoft Visual Basic. 

Built into these DLLs are sophisticated memory and data buffer management 
capabilities that free developers from having to deal with those complex issues. 

Using these DLLs lets you take advantage of the power and features of 
Microsoft Windows 3.11, Win-NT 4.0, Windows 95/98 and Windows 2000 for 
your data acquisition application.  These include running multiple applications 
and using extended memory.  Also, Visual Basic and ACLS-DLL2’s DLLs 
make it easy to create custom user interfaces and graphics. 

In addition to the DLL drivers, some sample programs are also provided; you 
can refer to it and save a lot of programming time and get some other benefits 
as well.  



2 • Introduction to ACLS DLL2 

1.2 Installing ACLS-DLL2 

1.2.1  System Requirements 

ACLS-DLL2 requires the following minimum configuration: 

• An IBM PC/AT or 100% compatible with an 80386 or higher processor 

• 4MB of available memory 

• A hard disk with enough disk space to install ACLS-DLL2 

• A 1.44-MB, 3.5-inch floppy disk drive or CD-ROM drive 

• Microsoft Windows 3.11, Windows 95/98, Win-NT 4.0 or Windows 2000  

• Application development system: Microsoft C/C++ and Windows SDK, 
Microsoft Visual C/C++, or Microsoft Visual Basic. 

• ACL-6126, ACL-6128, ACL-8111, ACL-8113, ACL-8113A, ACL-8112DG/HG, 
8112PG, ACL-8216, or ACL-8316/12 multi -function card 
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1.2.2  ACLS-DLL2 Installation 

The Setup program provided by ACLS-DLL2 performs all the tasks necessary 
for installing the ACLS-DLL2 components. 

To install ACLS-DLL2: 

With "ACLS-DLL2 Library & Utility" diskette: 

step 1. Place the diskette in the appropriate 3.5" floppy drive (A: or B:). 

step 2. If Windows is loaded, choose Run from the Start Menu. 

step 3. Typing the A:\SETUP or B:\SETUP in the Run dialog box.  

 
With “Manual & Software Utility” CD: 

step 1 Place ADLink All-in-one CD into the appropriate CD-ROM drive. 

step 2 If autorun setup program is not invoked automatically, please click the 
Start button on the Taskbar, and then choose Run. Type x: \setup (x 
identifies the drive that contains the compact disc) in Open text box, 
and then click OK. 

Step 3 Setup first displays the main screen. Select Software Package.  

Step 4 Setup then displays the ADLink software product screen. Select 
NuDAQ ISA Software.  

Step 5 In NuDAQ ISA Software screen select ACLS-DLL2. Then select the 
platform option. 

Setup first displays a Welcome dialog box. Please click Next button to go on 
installation. 

Setup then prompts a user information dialog box including Name, Company 
and Serial Number text fields. The “Serial Number” field must be filled in 
correctly, otherwise the ACLS-DLL2 will run in 120-minute demo mode.    

Setup then prompts a dialog box for you to specify the destination directory for 
ACLS-DLL2. The default path is C:\ADLink\ACL-DLL2. If you want to install 
ACLS-DLL2 in another directory, please click Browse button to change the 
destination directory. Then you can click Next to begin installing ACLS-DLL2.  

 
[Windows NT/2000 version] 

When the software component installation process is completed, Setup will 
launch the DLL2 Driver Registry Utility for you to make the registry of the 
drivers that you want to perform DMA or interrupt operation. 
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The DLL2 Driver Registry Utility first checks the system for the old version of 
DLL2 driver registry. If there any old version of DLL2 driver registry exists in 
the system, an old registry removal message box will appear as the figure 
below. For the new version of DLL2 working properly, click “OK” button. If the 
old version of DLL2 driver registry is not removed, when you re-start the 
Windows NT system, the system may crash.  

 
After the check of old version of DLL2 driver, the DLL2 Driver Registry Utility 
shows the following window. If any DLL2 driver has been registered, it will be 
shown on the Registerer Driver list.  

 

 
If the card you wish to operate DOES NOT want to perform interrupt or DMA 
operation, please click Done button to exit this utility.  
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To register one of DLL2 drivers, click New…  button and a Device 
Configuration window appears.  

 

 
From this window you can select the driver you want to register. Since Dll2 
drivers for Windows NT/2000 can support more than one device, you can 
configure more than one device for each Dll2 driver. The maximum number of 
device that each driver supports is as the following table.  

 
Driver Name Number of Device 

(Valid Device Name) 
6126 2 (Device0, Device1) 
8111 2 (Device0, Device1) 
8112 2 (Device0, Device1) 
8216 2 (Device0, Device1) 
8316 3 (Device0, Device1, 

Deivce2) 
If the driver you select has been registered, the “Device#” list gives the device 
names of the devices configured.  
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To add a device, click Add…  button and a Driver Configuration window 
appears for you to set DMA channel, IRQ level and base address. The Driver 
Configuration window is as the following figure: 

 
After the setting for DMA channel, IRQ level and base address, click OK and 
Device Configuration window re-appears. The device you just added is shown 
on “Device#” list as the following figure.  
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After the device configurations of the driver you select is finished, click OK 
button to register the driver and return to Driver Registry Utility main window. 
The driver you just registered will be shown on the registered driver list as the 
following figure: 

 

When you finish the driver registries, select Done button to exit this utility. To 
make the registered drivers work, you have to re-start Windows NT/2000 
system. 
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[Window 95/98 version] 
For DLL2 driver performs DMA operation properly, the system should know the 
DMA channels the devices will use. When the software component installation 
process is completed, Setup will launch the DLL2 DMA Channel Selection 
Utility for you to select the DMA channels. The DLL2 DMA Channel Selection 
Utility is shown as the following figure: 

 

 

Check the desired DMA channels and then click USE button to inform the 
system that the DMA channels the DLL2 devices will use. Then you select Exit! 
command in the menu bar to exit DLL2 DMA Channel Selection Utility. Re-start 
Windows 95/98 system to make the system DMA channels selection effective. 

 
[Window 95/98 , Window NT/2000 versions] 

When you have completed the installation process, the DLL2 directory should 
contain the following files and sub-directories: 
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File/Subdirectory  Description 
LIB <DIR> ACLS-DLL2 import libraries and DLLs 

Note: 
*.lib  for Microsoft C/C++ and Visual 
C/C++ programming, e.g. 8111.lib 
*_bc.lib for Borland C++ 
programming, e.g. 8111_bc.lib 

INCLUDE <DIR> Include files for application 
programming.   
DLL2.H for Microsoft C/C++ and 
Visual C/C++ programming. 
DLL2.BAS for Visual Basic 
Programming. 
DLL2.PAS for Delphi programming 

UTIL<DIR>  Registry utility of DLL2’s device 
drivers (Windows NT only) 
System DMA Selection utility 
(Windows 95 only)  

SAMPLES\SDK\6126 <DIR> ACL-6126 Visual C/C++ sample 
program 

SAMPLES\SDK\6126INT <DIR> ACL-6126 Interrupt AO Visual C/C++ 
sample program 

SAMPLES\SDK\6128 <DIR> ACL-6128 Visual C/C++ sample 
program 

SAMPLES\SDK\8111 <DIR> ACL-8111 Visual C/C++ sample 
program 

SAMPLES\SDK\8111INT <DIR> ACL-8111 Interrupt AI Visual C/C++ 
sample program 

SAMPLES\SDK\8111SCAN <DIR> ACL-8111 Interrupt AI with AutoScan 
mode , Visual C/C++ sample program 

SAMPLES\SDK\8111DBINT <DIR> ACL-8111 Continuous Interrupt AI 
Visual C/C++ sample program 

SAMPLES\SDK\8111DBSCAN 
<DIR> 

ACL-8111 Continuous Interrupt AI 
with AutoScan mode , Visual C/C++ 
sample program 

SAMPLES\SDK\8112 <DIR> ACL-8112 Visual C/C++ sample 
program 

SAMPLES\SDK\8112DMA <DIR> ACL-8112 DMA AI Visual C/C++ 
sample program 

SAMPLES\SDK\8112INT <DIR> ACL-8112 Interrupt AI Visual C/C++ 
sample program 



10 • Introduction to ACLS DLL2 

SAMPLES\SDK\8112SCAN <DIR> ACL-8112 Interrupt AI wit AutoScan 
mode , Visual C/C++ sample program 

SAMPLES\SDK\8112DBINT <DIR> ACL-8112 Continuous Interrupt AI 
Visual C/C++ sample program 

SAMPLES\SDK\8112DBSCAN 
<DIR> 

ACL-8112 Continuous Interrupt AI wit 
AutoScan mode , Visual C/C++ 
sample program 

SAMPLES\SDK\8112DBDMA <DIR> ACL-8112 Continuous DMA AI Visual 
C/C++ sample program 

SAMPLES\SDK\8113 <DIR> ACL-8113 Visual C/C++ sample 
program 

SAMPLES\SDK\8113A <DIR> ACL-8113A Visual C/C++ sample 
program 

SAMPLES\SDK\8112PG <DIR> ACL-8112PG Visual C/C++ sample 
program 

SAMPLES\SDK\812PGDMA <DIR> ACL-8112PG DMA AI Visual C/C++ 
sample program 

SAMPLES\SDK\812PGINT <DIR> ACL-8112PG Interrupt AI Visual 
C/C++ sample program 

SAMPLES\SDK\812PGSCAN <DIR> ACL-8112PG Interrupt AI with 
AutoScan mode,Visual C/C++ sample 
program 

SAMPLES\SDK\812PGDBINT 
<DIR> 

ACL-8112PG Continuous Interrupt AI 
Visual C/C++ sample program 

SAMPLES\SDK\812PGDBDMA 
<DIR> 

ACL-8112PG Continuous DMA AI 
Visual C/C++ sample program 

SAMPLES\SDK\8216 <DIR> ACL-8216 Visual C/C++ sample 
program 

SAMPLES\SDK\8216DMA <DIR> ACL-8216 DMA AI Visual C/C++ 
sample program 

SAMPLES\SDK\8216INT <DIR> ACL-8216 Interrupt AI Visual C/C++ 
sample program 

SAMPLES\SDK\8216SCAN <DIR> ACL-8216 Interrupt AI with AutoScan 
mode ,Visual C/C++ sample program 

SAMPLES\SDK\8216DBINT <DIR> ACL-8216 Continuous Interrupt AI 
Visual C/C++ sample program 

SAMPLES\SDK\8216DBDMA <DIR> ACL-8216 Continuous DMA AI Visual 
C/C++ sample program 

SAMPLES\SDK\8316 <DIR> ACL-8316 Visual C/C++ sample 
program 

SAMPLES\SDK\8316DMA <DIR> ACL-8316 DMA AI Visual C/C++ 
sample program 
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SAMPLES\SDK\8316INT <DIR> ACL-8316 Interrupt AI Visual C/C++ 
sample program 

SAMPLES\SDK\8316DBSCAN 
<DIR> 

ACL-8316 Continuous Interrupt AI 
with AutoScan mode ,Visual C/C++ 
sample program 

SAMPLES\SDK\8316DBINT <DIR> ACL-8316 Continuous Interrupt AI 
Visual C/C++ sample program 

SAMPLES\SDK\8316DBDMA <DIR> ACL-8316 Continuous DMA AI Visual 
C/C++ sample program 

SAMPLES\VB\6126 <DIR> ACL-6126 Visual Basic sample 
program 

SAMPLES\VB\6128 <DIR> ACL-6128 Visual Basic sample 
program 

SAMPLES\VB\8111 <DIR> ACL-8111 Visual Basic sample 
program 

SAMPLES\VB\8112 <DIR> ACL-8112 Visual Basic sample 
program 

SAMPLES\VB\8112DMA <DIR> ACL-8112 DMA AI Visual Basic 
sample program 

SAMPLES\VB\8112INT <DIR> ACL-8112 Interrupt AI Visual Basic 
sample program 

SAMPLES\VB\8112CINT <DIR> ACL-8112 Continuous Interrupt AI 
Visual Basic sample program 

SAMPLES\VB\8112SCAN <DIR> ACL-8112 Interrupt AI with AutoScan 
mode , Visual Basic sample program 

SAMPLES \VB\8112CDMA <DIR> ACL-8112 Continuous DMA AI Visual 
Basic sample program 

SAMPLES\VB\8112PG <DIR> ACL-8112PG Visual Basic sample 
program 

SAMPLES\VB\8113 <DIR> ACL-8113 Visual Basic sample 
program 

SAMPLES\VB\8216 <DIR> ACL-8216  Visual Basic sample 
program 

SAMPLES\VB\8216DMA <DIR> ACL-8216 DMA AI Visual Basic 
sample program 

SAMPLES\VB\8216INT <DIR> ACL-8216 Interrupt AI Visual Basic 
sample program 

SAMPLES\VB\8316 <DIR> ACL-8316  Visual Basic sample 
program 

SAMPLES\VB\8316DMA <DIR> ACL-8316 DMA AI Visual Basic 
sample program 

SAMPLES\VB\8316INT <DIR> ACL-8316 Interrupt AI Visual Basic 
sample program 
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All ACLS-DLL2’s DLLs are also copied to Windows System directory (default is 
C:\WINDOWS\SYSTEM for Windows 3.11 or Win-95/98, C:\Winnt\System32 
for Windows NT/2000). 

The driver files are also copied to the appropriate directory: 

• Windows 3.11 Version: ACLVDMA1.386 and ACLVDMA3.386 are copied to 
Windows System directory.  

• Win-95/98 Version: ACLVDMA1.386, ACLVDMA3.386, ACLVDMA5.386, 
ACLVDMA6.386, ACLVDMA7.386, W95_DLL2.VXD, W95_DL22.VXD, and 
W95_8316.VXD are copied to Win-95/98 System directory. 

• Windows NT/2000 Version: DIO.SYS, 6126.SYS, 8111.SYS, 8112.SYS, 
8216.SYS, and 8316.SYS are copied to Win-NT/2000 System Drivers 
directory (default is C:\Winnt\System32\Drivers). 

1.2.4  ACLS-DLL2 Un-installation 

ACLS-DLL2 software has the capability of automatic un-installation. 

To un-install ACLS-DLL2, open the “Control Panel”, double-click “Add/Remove 
Programs”, select ACLS-DLL2 to un-install it.  

1.3 ACLS-DLL2 Hardware Support 

The ACLS-DLL2 supports the following hardware: 
ACL-6126   : 6 Channels, 12-bit Voltage & Current Outputs Card 
ACL-6128   : Isolated 2 Channels Analog Output Card 
ACL-8111   : Multi-function Data Acquisition Card  
ACL-8112DG/HG : Enhanced Multi-function Data Acquisition Card 
ACL-8112PG : Enhanced Multi-function Data Acquisition Card 
ACL-8113/8113A  : 32 Channels Signal-ended Isolated A/D Card 
ACL-8216   : 16-bit High Resolution Multi -function DAS Card 
ACL-8312/8316 : 12/16-bit High Resolution/Performance DAS Card with FIFO 

1.4 ACLS-DLL2 Language Support 

ACLS-DLL2 is DLLs (Dynamic-Link Library) for use under Windows 
3.1/95/98/NT/2000. It can work with any Windows programming language that 
allows calls to a DLL, such as Microsoft Visual C/C++ (4.0 or above), Borland 
C++ (5.0 or above), or Microsoft Visual Basic (4.0 or above), etc. 
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1.5 System Architecture 

The following diagram shows the interface between your applications and 
ACLS-DLL2 drivers: 
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1.6 ACLS-DLL2 Device Driver Handling in Win-
NT/2000 

[Under Win-NT 4.0] 

When you completed the ACLS-DLL2 installation in Win-NT, please be careful 
of the following issue: 

Make sure the ACLS-DLL2 device drivers (6126, 8111, 8112, 8216, 8316 or 
Dio) are already started. You can open the “Control Panel”, double-click 
“Devices”, and a Devices windows will be shown as below. 

 

 
 

If the device status is none, you have to select the 6126, 8111, 8112, 8216, 
8316 or Dio device and press the Start button.    

If your device driver can not be started, please check if the resources (I/O Port 
Address, IRQ Level, or DMA Channel) of all the devices of this driver conflict 
with other hardware device. (Note: If at least one device of this driver is loaded 
successfully, the device status will be “Started”). You can use a Windows NT 
built-in program “Windows NT Diagnostics” to get the resource information in 
your system. To evoke this program, select Programs from Start menu, choose 
“Administration Tools”, and then a Windows NT Diagnostics window will be 
shown as below:  
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Each button in this window links to the corresponding hardware information. 
Therefore you can get the resource allocation information in your system and 
check if your DLL2 devices are loaded successfully. Please refer to Windows 
NT user’s manual for the details about this program. The resource setting 
modification of DLL2 devices is described in following section. 

Note : The resource usage information Windows NT Diagnostics 
program provides is only the information the hardware 
drivers which have made registry in NT system. If some 
devices set their resource request in CMOS (e.g. LPT1), but 
don’t make registry in NT system, you can’t get their 
resource information from Windows NT Diagnostics 
program. Please refer to Appendix A for the general I/O port 
address map and IRQ settings. 

[Under Win-2000] 

When you completed the ACLS-DLL2 installation in Win-2000, please be 
careful of the following issue: 

Make sure the ACLS-DLL2 device drivers (6126, 8111, 8112, 8216, 8316 or 
Dio) are already started. You can open the Device Manager in 
Start>>Settings>>Control Panel>>System, and then select the Hardware tab. 
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In Device Manager, you should select Show hidden devices item to display 
the Non-Plug and Play Drivers. 
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And then you can double-click the device and select the Resources tab to 
check if I/O port and IRQ resources for the device are allocated successfully.  

If your DLL2 devices are not loaded successfully, you will get the GRAY icons 
in Device Manager as follows: 

 
Double-click the icon, the Device Status will show the error massage as the 
following figure: 
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To solve this problem, you can right-click  the device icon, and select the Scan 
for hardware changes item in pop-up menu. The system will re-load the 
device drivers with the resource registered in system registry. 

 

1.6.1 ACLS-DLL2 Device Driver Configuration 

ACLS-DLL2 provides a utility, DLL2 Driver Registry Utility. This utility is used 
for users to make the registry of new DLL2 drivers (the drivers you want to 
perform DMA or interrupt operation), remove installed drivers and modify the 
base address, DMA channel and IRQ level settings of installed drivers. The 
DLL2 Driver Registry Utility main window is as the following figure. The DLL2 
Driver Registry Utility is installed with ACLS-DLL2 and located in 
<InstallDir>\Util directory.  
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Using this utility to install a new driver, please refer to section 2.1.3.  

Using DLL2 Driver Registry Utility to change the settings of one device of 
one of the ACLS-DLL2 drivers, select the driver from the Registered Driver list 
and click “Modify… ” button and then a “Driver Configuration” window is shown 
as below. The “Device#” list gives the device names of the devices configured.  

 
To modify the settings of IRQ level, DMA channel and Base Address of a 
device, click “Modify… ” button and a Driver Configuration window appears for 
you to modify DMA channel, IRQ level and base address. 
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Inside the Base Address, DMA and IRQ fields are the originally set values. 
Modify the values and then click “OK” button. The settings for the device will be 
changed as you modified and return to Device Configuration window. Then you 
can click ‘OK” button in Device Configuration window and the settings for the 
driver will be modified.  

To remove a registered driver, select the driver from the Registered Driver list 
in The DLL2 Driver Registry Utility main window and click “Remove” button. 
The selected driver will be deleted from the registry table. 
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1.7 Using ACLS-DLL2 

1.7.1 Creating An Application Using Visual Basic and ACLS-
DLL2 

 
To create a data acquisition application using ACLS-DLL2 and Visual Basic, 
follow these steps after entering Visual Basic: 

step 1. Open the project in which you want to use ACLS-DLL2.  This can be a 
new or existing project  

Open a new project by selecting the New Project command from the File menu.  
If it is an existing project, open it by selecting the Open Project command from 
the File menu.  Then the Open Project dialog box appears. 

 
 

Changed directory to the place the project file located.  Double-click the project 
file name in the File Name list to load the project. 

step 2. Add file DLL2.BAS into the project if this file is not included in the 
project.  This file contains all the procedure declarations and constants 
that you can use to develop your data acquisition application. 

From the File menu, select the Add File command.  The Add File window 
appears, displaying a list of files in the current directory. 
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Select DLL2.BAS from the Files list by double clicking on it.  If you can't find 
this file in the list, make sure the list is displaying files from the correct directory.  
By default, DLL2.BAS is installed in C:\ACL-DLL2\INCLUDE. 

 
step 3. Design the interface for the application. 

To design the interface, you place the desired elements, such as command 
button, list box, text box, etc., on the Visual Basic form.  These are standard 
controls from the Visual Basic Toolbox.  To place a control on a form, you just 
move pointer to Toolbox, select the desired control and draw it on the form. Or 
you can double-click the control icon in the Toolbox to place it on the form. 

step 4. Set properties for the controls. 

To view the property list, click the desired control and then choose the 
Properties command from the View menu or press F4, or you can also click the 

Properties button  on the toolbar. 

step 5. Write the event code. 

The event code defines the action you want to perform when an event occurs.  
To write the event code, double-click the desired control or form to view the 
code module and then add code you want.  You can call the functions that 
declared in the file DLL2.BAS to perform data acquisition operations. 

step 6. Run your application. 

To run the application, choose Start from the Run menu, or click the Start icon 

 on the toolbar (you can also press F5). 
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step 7. Distribute  your application. 

Once you have finished a project, you can save the application as an 
executable (.EXE) file by using the Make EXE File command on the File menu.  
And once you have saved your application as an executable file, you've ready 
to distribute it.  When you distribute your application, remember also to include 
the ACLS-DLL2’s DLL and driver files.  These files should be copied to their 
appropriate directory as section 2.1.3 described. 

1.7.2 Creating An Application Using Microsoft Visual C/C++ and 
ACLS-DLL2 

To create a data acquisition application using ACLS-DLL2 and Microsoft Visual 
C/C++, follow these steps after entering Visual C/C++: 

 
step 1. Open the project in which you want to use ACLS-DLL2.  This can be a 

new or existing project  

step 2. Include header file DLL2.H in the C/C++ source files that call ACLS-
DLL2 functions.  DLL2.H contains all the function declarations and 
constants that you can use to develop your data acquisition application.  
Incorporate the following statement in your code to include the header 
file. 

  #include  “DLL2.H” 

step 3. Build your application. 

Setting the appropriate compile and link options, then build your application by 
selecting the Build command from Build menu (Visual C/C++ 4.0) or Project 
menu (Visual C/C++ 1.52). Remember to link appropriate ACLS-DLL2’s import 
libraries.   
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2 

Software Overview 

Each NuDAQ ISA-bus multi -function card has its own DLL driver.  How to use 
these DLL to build your own application has been described in section 1.7.  
The function calls in these DLLs use intuitive names that reflect the operations 
they perform.  For example, 

W_8111_AD_Set_Channel sets the A/D reading channel. 

The functionality of these function calls can be classified to the following 
capabilities, 

1. Initialization  : setup the hardware base I/O address 

2. A/D conversion : performs analog to digital conversion 

3. D/A conversion : performs digital to analog conversion  

4. Digital I/O : input or output digital signals 

5. Timer/Counter  : Timer/Counter operation 

 
In addition, some sample programs are also included in this disk. They help 
you to understand how to use the driver more quickly.  

We defined some data types in DLL2.H.  These data types are used by ACLS-
DLL2 library.  We suggest you to use these data types in your application 
programs.  The following table shows the data type names and their ranges. 
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Type Name Description Range 
U8 8-bit ASCII character 0 to 255 
I16 16-bit signed integer -32768 to 32767 
U16 16-bit unsigned integer 0 to 65535 
I32 32-bit signed integer -2147483648 to 

2147483647 
U32 32-bit unsigned integer 0 to 4294967295 
F32 32-bit single-precision 

floating-point 
-3.402823E38  to 
3.402823E38 

F64 64-bit double-precision 
floating-point 

-1.797683134862315E308 to 
1.797683134862315E309 

Boolean Boolean logic value TRUE, FALSE 
 

The ACLS-DLL2 contains eight multi-function cards' DLL drivers. They are 
6126.DLL, 6128.DLL, 8111.DLL, 8112.DLL, 8112PG.DLL, 8113.DLL, 
8113A.DLL, 8216.DLL and 8316.DLL.  

2.1 Software Driver Naming Convention 

The functions of ACL-DLL2 use full-names to represent the real meaning of the 
functions. The naming convention rules are: 

W_{hardware_model}_{action_name}. e.g. W_8111_Initial (). 

 

 



 Software Overview • 27 

2.2 Initialization and General Configuration 
Functions 
 

W_{hardware_model}_Initial Initializes the hardware and the 
software status  of a NuDAQ ISA-
Based multi -function card according 
to the card number and the 
corresponding base address.    
 

W_{hardware_model}_Switch_Card_No 
W_{hardware_model}_ActCard_Set 
 

Sets the status of the card you want 
to operate to be active in a multi -
cards system.  
 

2.3 A/D Conversion Functions 
W_{hardware_model}_AD_Input_Mode Informs ACLS-DLL2 of the 

A/D input mode (single-
ended or differential). 
 

W_{hardware_model}_AD_Set_Channel 
W_{hardware_model}_AD_Channel_Select 

Selects the specified analog 
input channel. 

W_{hardware_model}_AD_Channel_Deselect Removes the specified 
analog input channel from 
the list of selected channels 
(This function is only 
available for ACL-
8113/8113A card). 

W_{hardware_model}_AD_Channel_Clear Clears all of the analog 
input channels from the list 
of selected channels, and 
no channel is selected (This 
function is only available for 
ACL-8113/8113A card). 
 

W_{hardware_model}_AD_ChannelNo_Get Gets the number of the 
selected channels (This 
function is only available for 
ACL-8113/8113A card). 
 

W_{hardware_model}_AD_Set_Gain 
W_{hardware_model}_Gain_Select 
W_{hardware_model}_AD_Set_Range 

Informs ACLS-DLL2 of the 
A/D analog input range. 
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W_{hardware_model}_AD_Set_Mode Informs ACLS-DLL2 of the 
A/D trigger and data 
transfer mode. 
 

W_8316_AD_Set_Autoscan Enables automatic channel 
scan for A/D conversion 
(This function is only 
available for ACL-8316/12 
card). 
 

W_8316_AD_Set_FIFO Enables the FIFO on the 
ACL-8316/12 (This function 
is only available for ACL-
8316/12 card). 
 

W_8316_AD_Read_FIFO Gets the A/D conversion 
data stored in the FIFO on 
the ACL-8316/12 card (This 
function is only available for 
ACL-8316/12 card).  
 

W_{hardware_model}_AD_Soft_Trig Triggers the A/D conversion 
by software. 
 

W_{hardware_model}_AD_Aquire Polls the A/D conversion 
data 
 

W_{hardware_model}_MAD_Aquire Polls the A/D conversion 
datum from the selected 
channels and puts the 
datum in a specified array 
(This function is only 
available for ACL-
8113/8113A card). 
 

W_{hardware_model}_Get_MAD_Data Gets the datum from a 
specified data array (This 
function is only available for 
ACL-8113/8113A card). 
 

W_{hardware_model}_AD_Set_INT_Source Informs ACLS-DLL2 of the 
interrupt trigger source for 
the A/D analog input. 
 

W_{hardware_model}_CLR_IRQ Clear an interrupt request  
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W_{hardware_model}_AD_INT_Start Performs A/D analog input 

N times with interrupt data 
transfer by using 
external/internal interrupt 
trigger. 
 

W_{hardware_model}_AD_ContINT_Start Performs continuous A/D 
analog input with interrupt 
data transfer by using 
external/internal interrupt 
trigger. 
 

W_{hardware_model}_AD_SCANINT_Start Performs automatic channel 
scan for A/D conversion 
with interrupt data transfer 
by using external/internal 
interrupt trigger. 

W_{hardware_model}_AD_INT_Staus Checks the current status of 
the interrupt operation. 
 

W_{hardware_model}_AD_INT_Stop Stops the interrupt data 
transfer. 
  

W_{hardware_model}_AD_DMA_Start Performs A/D analog input 
N times with DMA data 
transfer by using 
external/internal interrupt 
trigger. 
 

W_{hardware_model}_AD_ContDMA_Start Performs continuous A/D 
analog input with DMA data 
transfer by using 
external/internal interrupt 
trigger. 
 

W_{hardware_model}_ AD_DMA_Status Checks the current status of 
A/D analog input with DMA 
data transfer. 
 

W_{hardware_model}_ AD_DMA_Stop Stops A/D analog input with 
DMA data transfer. 
 

W_{hardware_model}_ AD_DblBufferHalfReady Check whether data half full 
or not in circular buffer. 
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W_{hardware_model}_ AD_DblBufferTransfer Copy the converted A/D 
data from circular buffer to 
user buffer. 

2.4 D/A Conversion Functions 
W_{hardware_model}_DA_Set_Mode Informs ACLS-DLL2 of the 

D/A output mode (This 
function is only available for 
ACL-8316/12 card). 
 

W_{hardware_model}_DA Writes data to one of the 
analog output channels, 
changing the voltage 
produced at the channel. 
 

Set_INT_Op Informs ACLS-DLL2 of the 
D/A channel and the data 
buffer that will be used to 
perform D/A conversion with 
interrupt data transfer (This 
function is only available for 
ACL-6126 card). 
 

Reset_INT_Op Reset the D/A channel and 
data buffer settings of D/A 
conversion with interrupt 
data transfer (This function 
is only available for ACL-
6126 card).  
 

W_6126_INT_Start Initializes and starts up the 
D/A conversion with 
interrupt control of ACL-
6126 card (This function is 
only available for ACL-6126 
card). 
 

W_6126_INT_Status Checks the current status of 
D/A conversion with 
interrupt operation of ACL-
6126 card (This function is 
only available for ACL-6126 
card). 
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W_6126_INT_Stop Stops the D/A conversion 

with interrupt operation of 
ACL-6126 card (This 
function is only available for 
ACL-6126 card). 
 

2.6 Digital I/O Functions 
 

W_{hardware_model}_DI Reads the digital data from the 
specified input port. 
 

W_{hardware_model}_DI_Channel Reads the digital data from the 
specified input channel. 
 

W_{hardware_model}_DO Writes the digital data to the 
specified output port. 
 

W_{hardware_model}_DO_Channel Writes the digital data to the 
specified output line. 
 

2.7 Timer/Counter Operation Functions 
 

W_{hardware_model}_AD_Timer Starts up internal Timers for generating 
constant A/D trigger signal dedicatedly. 
 

W_{hardware_model}_Timer_Start Start up Timer #0 to operate in the 
specified mode. 
 

W_{hardware_model}_Timer_Stop Stop Timer #0. 
 

W_{hardware_model}_Timer_Read Reads the current contents of Timer #0. 
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3 

Sample Programs 

3.1 Sample Programs Included 

There are several sample programs provided in this software diskette. They 
could help you to program your own applications by using ACLS-DLL2 easily. 
The brief descriptions of these programs are specified as follows: 

 
SDK 6126  D/A conversion, D/I, and D/O of ACL-6126 

Microsoft C/C++ Program 
 

SDK 6126INT   D/A conversion of ACL-6126 through Interrupt 
operation 
Microsoft C/C++ Program 
 

SDK 6128  D/A conversion of ACL-6128 
Microsoft C/C++ Program 
 

SDK 8111 / 
VB 8111    

A/D conversion, D/A conversion, D/I, and D/O of 
ACL-8111  
Microsoft C/C++ Program  
Visual Basic Program 
 

SDK 8111INT A/D conversion of ACL-8111 through Interrupt 
operation 
Microsoft C/C++ Program 
 

SDK 8111 AutoScan A/D conversion of ACL-8111 AutoScan mode 
through Interrupt operation 
Microsoft C/C++ Program 
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SDK 8111 ContINT Continuous A/D conversion of ACL-8111 
through Interrupt operation 
Microsoft C/C++ Program 

SDK 8111 
ContAutoScan 

Continuous A/D conversion of ACL-8111 
AutoScan mode through Interrupt operation 
Microsoft C/C++ Program 

SDK 8112 / 
VB 8112    

A/D conversion, D/A conversion, D/I, and D/O of 
ACL-8112DG/HG  
Microsoft C/C++ Program  
Visual Basic Program 
 

SDK 8112DMA / 
VB 8112DMA    

A/D conversion of ACL-8112DG/HG  through 
DMA data transfer 
Microsoft C/C++ Program 
Visual Basic Program 
 

SDK 8112INT / 
VB 8112INT    

A/D conversion of ACL-8112DG/HG through 
Interrupt operation 
Microsoft C/C++ Program 
Visual Basic Program 
 

SDK 8112AutoScan/ 
VB 8112AutoScan 

A/D conversion of ACL-8112DG/HG AutoScan 
mode through Interrupt operation 
Microsoft C/C++ Program 
Visual Basic Program 

SDK 8112 ContINT/ 
VB 8112 ContINT 

Continuous A/D conversion of ACL-8112DG/HG 
through Interrupt operation 
Microsoft C/C++ Program 
Visual Basic Program 

SDK 8112 
ContAutoScan 

Continuous A/D conversion of ACL-8112DG/HG 
AutoScan mode through Interrupt operation 
Microsoft C/C++ Program Visual Basic Program 

SDK8112ContDMA/ 
VB 8112 ContDMA 

Continuous A/D conversion of ACL-8112DG/HG  
through DMA data transfer 
Microsoft C/C++ Program Visual Basic Program 

SDK 8112PG / 
VB 8112PG    

A/D conversion, D/A conversion, D/I, and D/O of 
ACL-8112PG 
Microsoft C/C++ Program 
Visual Basic Program 
 

SDK 812PGINT  A/D conversion of ACL-8112PG through 
Interrupt operation 
Microsoft C/C++ Program 
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SDK 812PGDMA  A/D conversion of ACL-8112PG through DMA 
data transfer operation 
Microsoft C/C++ Program 
 

SDK 812PG 
AutoScan 

A/D conversion of ACL-8112PG AutoScan mode 
through Interrupt operation 
Microsoft C/C++ Program 

SDK 812PG ContINT Continuous A/D conversion of ACL-8112PG 
through Interrupt operation 
Microsoft C/C++ Program 

SDK 812PG 
ContDMA 

Continuous A/D conversion of ACL-8112PG 
through DMA data transfer operation 
Microsoft C/C++ Program 

SDK 8113  A/D conversion of ACL-8113 
Microsoft C/C++ Program 
 

SDK 8113A  A/D conversion of ACL-8113A 
Microsoft C/C++ Program 
 

SDK 8216/ 
VB 8216  

A/D conversion, D/A conversion, D/I, and D/O of 
ACL-8216 
Microsoft C/C++ Program  
Visual Basic Program 
 

SDK 8216DMA/ 
VB 8216DMA  

A/D conversion of ACL-8216 through DMA data 
transfer 
Microsoft C/C++ Program  
Visual Basic Program 
 

SDK 8216INT/ 
VB 8216INT  

A/D conversion of ACL-8216 through Interrupt 
operation 
Microsoft C/C++ Program  
Visual Basic Program 
 

SDK 8216 AutoScan A/D conversion of ACL-8216 AutoScan mode 
through Interrupt operation 
Microsoft C/C++ Program 

SDK 8216 ContINT Continuous A/D conversion of ACL-8216 
through Interrupt operation 
Microsoft C/C++ Program 

SDK 8216ContDMA Continuous A/D conversion of ACL-8216 
through DMA data transfer 
Microsoft C/C++ Program 
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SDK 8316/ 
VB 8316  

A/D conversion, D/A conversion, D/I, and D/O of 
ACL-8316 
Microsoft C/C++ Program  
Visual Basic Program 
 

SDK 8316DMA/ 
VB 8316DMA  

A/D conversion of ACL-8316 through DMA data 
transfer 
Microsoft C/C++ Program  
Visual Basic Program 
 

SDK 8316INT/ 
VB 8316INT  

A/D conversion of ACL-8316 through Interrupt 
operation 
Microsoft C/C++ Program  
Visual Basic Program 
 

SDK 8316 ContINT Continuous A/D conversion of ACL-8316 
through Interrupt operation 
Microsoft C/C++ Program 

SDK 8316 
ContAutoScan 

Continuous A/D conversion of ACL-8316 
AutoScan mode through Interrupt operation 
Microsoft C/C++ Program 

SDK 8316ContDMA Continuous A/D conversion of ACL-8316 
through DMA data transfer 
Microsoft C/C++ Program 
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3.2 Sample Programs Developed Environment 

3.2.1 Visual Basic Sample Programs 

There are eight Visual Basic sample programs provided in this software 
package. By default, they are located in directory C:\ACL-DLL2\SAMPLES\VB. 
The following files are included in each sample program (Using VB 8112int as 
an example): 

• VB project file --- 8112INT.VBP 

• VB form files --- 8112INT.FRM, FRMADDR.FRM 

• Executable file --- 8112INT.EXE  

You must have Microsoft Visual Basic 4.0 Professional Edition or above to deal 
with these sample programs. Please refer to Visual Basic Manual or related 
reference books to get the information about how to use Visual Basic 4.0.    

3.2.2 Microsoft C/C++ Sample Programs 

We provide nine Microsoft C/C++ sample programs in this package. By default, 
they are located in directory C:\ACL-DLL2\SAMPLES\SDK. The following files 
are included in each sample program (Using SDK 8112 as an example): 

• C source file --- UTIL8112.C 

• Workspace file --- UTIL8112.MDP 

• Resource script file --- UTIL8112.RC, RESOURCE.H 

• Make file --- UTIL8112.MAK 

• Executable file --- UTIL8112.EXE 

You can use any editor or Microsoft Visual C++ 4.0 to view or modify these 
source files. However, to build the executable UTIL8112.EXE, you must have 
Microsoft Visual C++ 4.0 or above. Please refer to Visual C++ Manual or 
related reference books to get the information about how to use Visual C++ 4.0.    
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3.3 Execute Sample Programs  

To run the sample programs, please follow these step (Using 
SDK8112/VB8112 as example): 

step 1. Open the sample program  

You can use Microsoft Visual C++ 4.0 or Visual Basic 4.0 to open and execute 
the sample programs. Or you can run the executable files directly.  

step 2. Configuration Setting 

According to the configuration setting on your NuDAQ card, input the related 
Base Address, IRQ, DMA Channel number (only support DMA channel 1) and 
Input Mode of the card in “setup” dialog box (Figure 3.1). 

 

 
Figure 3.1 

Note: If your environment is Windows NT and your irq level is not the same as 
the default value, please refer to section 2.4 to learn how to change irq level.  

step 3. Option Setting 

According to your requirements, select the testing functions, e.g. A/D, 
D/A, ..etc., testing channels, sampling rate and data value (transfer count).  

step 4. Push “start” button to run the program. 
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3.4 The Detailed Descriptions of these Sample 
Programs 

There are three kinds of sample programs provided in this software package. 
The descriptions of these three types are the following (Using the screens of 
VB 8112, SDK 8112DMA and SDK 8112INT as the figure examples) : 

3.4.1 A/D conversion, D/A conversion, D/I, and D/O 

This kind of samples are used to demonstrate how to use ACLS-DLL2 to 
operate software trigger with program polling data mode and Read/Write data 
from digital input/output channels. The main screen of this kind of programs is 
shown below (Figure 3.2):  

 

 
Figure 3.2 

Analog Input (A/D) : This is used to show the results of A/D conversion. You 
can select the Input channels (multi-channels) and the input range(gain) you 
want from the main screen.   



 Sample Programs • 39 

Analog output (D/A): This is used to show the results of D/A conversion. 
Dragging the scroll bar (SDK sample) or turning the knob (VB sample) to set 
the output voltage. In VB program, you can also choose the output waveform 
(sine or square).   

D/I and D/O: This is used to show the results of Read/Write data from/to digital 
input/output channels. To set the output value, click the channel lights. The red 
light means “on” and the white light means “off”.  

3.4.2 A/D conversion through DMA Data Transfer 

This kind of programs is used to demonstrate how to use ACLS-DLL2 to 
operate A/D conversion through DMA data transfer. The main screen of this 
kind of programs is shown below (Figure 3.3):  

 

 
Figure 3.3 

In this kind of programs you can select Input channels (Multi-channels), 
Sampling Rate, Input range and data size (Transfer count) as you wish. To 
view the input data, push “Data Value” button in the main screen as data 
transfer is finished (Figure 3.4). 
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Note: These DMA sample programs only support DMA channel 1.  

 

 
Figure 3.4 
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3.4.3 A/D conversion through Interrupt 

This kind of programs is used to demonstrate how to use ACLS-DLL2 to 
operate A/D conversion through Interrupt operation. The screen of this kind of 
programs is shown below (Figure 3.5) :  

 

 
Figure 3.5 

In this kind of programs you can select Input channels (Multi-channels), 
Sampling Rate, input range and data size (Transfer count) as you wish. To 
view the input data, push “Data Value” button in the main screen as data 
transfer operation is finished. 
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4 

Distribution of Applications 

4.1 Files And Registries 

To install an application using ACLS-DLL2 on another computer, you also must 
install the necessary driver files and supporting libraries on the target machine. 
You can redistribute the related files located in \Software\Acls-dll2\W95\redist 
or \Software\Acls-dll2\Wnt\redist on ADLink All-In-One CD. You can create an 
automatic installer to install your program  and all of the files needed to run that 
program or you can manually install the program and program files. Whichever 
installation method you choose, you must install the following files: 

4.1.1 Files 

Windows 95/98 

The corresponding library files in \Software\Acls-dll2\W95\redist\lib, e.g. 
8112.dll for ACL-8112DG/HG. These files should be copied to 
Windows\system directory. 

The corresponding driver files in \Software\Acls-dll2\W95\redist\drivers. These 
files should be copied to Windows \system directory. The required driver file for 
each Dll2 device is as the following table: 

Device Driver file 
Acl-6126 W95_dll2.vxd 
Acl-6128 Not needed 
Acl-8111 W95_dll2.vxd 
Acl-8112DG/HG/PG w95_dl22.vxd, 

Aclvdma1.386, 
Aclvdma3.386 

Acl-8113 Not needed 
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Acl-8216 w95_dl22.vxd, 
Aclvdma1.386, 
Aclvdma3.386 

Acl-8316 w95_8316.vxd, 
Aclvdma5.386, 
Aclvdma6.386, 
Aclvdma7.386 

DLL2 DMA Channel Selection Utility in \Software\Acls-dll2\W95\redist\Util. 

Windows NT 4.0 / 2000 

The corresponding library files in \Software\Acls-dll2\Wnt\redist\lib, e.g. 
8112.dll for ACL-8112DG/HG. These files should be copied to Winnt\system32 
directory. 

dio.sys in \Software\Acls-dll2\Wnt\redist\drivers. This file should be copied to 
Winnt\system32\drivers directory. 

The corresponding interrupt/DMA driver files in \Software\Acls-
dll2\Wnt\redist\drivers, e.g. 8112.sys for ACL-8112DG/HG/PG. These files 
should be copied to Winnt\system32\drivers directory. (There is no 8113.sys 
since ACL-8113 card has no interrupt or DMA functionality.) 

Device configuration utility in \Software\Acls-dll2\Wnt\redist\Util. You have to 
run this utility on the target system to register the drivers. 

4.1.2 Registries 

In addition to install the above files, you have to register the correct ACLS-
DLL2 serial number on the target machine. You have to make the following 
registry value (string type) on the target machine: 

Windows 95/98 

HKEY_LOCAL_MACHINE\Software\ADLink\ACLS-DLL2/95\CurrentVersion\Serial  

Windows NT 4.0 / 2000 

HKEY_LOCAL_MACHINE\Software\ADLink\ACLS-DLL2/NT\CurrentVersion\Serial  

And set the value of this string to your ACLS-DLL2 serial number. 
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4.2 Automatic Installers 

Many programming environments include some form of setup or distribution kit 
tool. This tool automatically creates an installation program for your program 
so that you can easily install it on another computer. To function successfully, 
this tool must recognize which control files and supporting libraries are 
required by your program and include these in the installation program it 
creates.  

Some of these tools, such as the Visual Basic 5 Setup Wizard, use 
dependency files to determine which libraries are required by a VB application.  

Some setup tools might not automatically recognize which files are required by 
a program but provide an option to add additional files to the installation 
program. In this case, verify that all the necessary files described in the 
previous section are included. You also should verify that the resulting 
installation program does not copy older versions of a file over a newer version 
on the target computer. 

Most of the tools can let you make the registry to the system. You can use it to 
make the registry mentioned above. If it does not have the capability, you can 
use the registry file dll2.reg in \Software\Acls-dll2\W95\redist\Util or 
\Software\Acls-dll2\Wnt\redist\Util to make the registry.  

Please edit the file dll2.reg. Add your ACLS-DLL2 serial number to the last line 

"Serial"="" 

For example 

"Serial"="A02-12345678" 

Then you can make the registry of the serial number by opening the registry 
file. 

If your programming environment does not provide a tool or wizard for building 
an installation program, you can use third-party tools such as InstallShield. 
Some programming environments provide simplified or trial versions of third-
party installer creation tools on their installation CDs. 
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4.3 Manual Installation 

If your programming environment does not include a setup or distribution kit 
tool, you can perform the installation task manually. To install your program on 
another computer, follow these steps: 

1. Copy the program executable to the target computer. 

2. Copy all the required files described in the section 4.1.1 to the 
appropriate directory on the target computer. 

Note: Do not replace any files on the target computer if the file on 
the target computer has a newer version than the file you 
are installing. 

Please use the registry file dll2.reg in \Software\Acls-dll2\W95\redist\Util or 
\Software\Acls-dll2\Wnt\redist\Util to make the registry. Add your ACLS-DLL2 
serial number to the last line 

"Serial"="" 

For example 

"Serial"="A02-12345678" 

Then you can make the registry of the serial number by opening the registry 
file. 
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Appendix A.  General 
Hardware Resource 
Allocation information   

1 I/O Port Address Map 
I/O Address (Hex.) Device 

000-01F DMA Controller 
020-03F Interrupt controller 
040-05F Timer 
060-06F Keyboard 
070-07F Real-time clock 
080-09F DMA page register 
0A0-0B0 Interrupt Controller 2 
0C0-0DF DMA controller 
0F0-0FF Math corprocessor 
100-1EF Not usable 
1F0-1F8 Fixed disk 
200-207 Game I/O 
278-27F LPT2 
2F8-2FF COM2 
300-31F Prototype card 
360-36F Reserved 
378-37F LPT1 
3B0-3BF Monochrome display 
SC0-3CF Reserved 
3D0-3DF Color graphics display 
3F0-3F7 Floppy disk controller 
3F8-3FF COM1 
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2 IRQ Settings 
IRQ Device 
0 Timer 
1 Keyboard 
2 Interrupt controller 
3 COM2 
4 COM1 
6 Floppy disk controller 
7 LPT1 
8 CMOS/Real timer clock 
9 Cascaded 
13 Math coprocessor 
14 Primary IDE controller 
15 Secondary IDE controller 

 
 


